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Overview

BWF-D-Base is a companion program to BWF-Widget and BWF-Widget Pro that is
designed to work with the Tab Delimited data files saved by both of those programs.
Unlike BWF-Widget, the actual sound files do not need to be accessible in order to work
with the metadata that was read from them and saved in the data files. You can load any
number of the data files from any number of disks into a single grid. The Data files do
not have to have the same fields in the same order in order to properly categorize the data
from the different disks or folders. Once you have all the data files loaded into the grid
you can sort the data on any field, or bring up the search window to create sub-Grids
which contain specific data you are looking for. Search results can be saved as new data
files or printed as reports. As in BWF-Widget and BWF-Widget Pro, the saved data files
are simple text files with Tab delimited fields with a single Carriage Return at the end of
each record. These compound files can be loaded back into BWF-D-Base at a later time
or they can be imported to any spreadsheet or database program.
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Loading Files

After launching the program you start by using the Drive list, directory list and file list
box to navigate to the location of your data files. Select all the files you want to add in the
file list and click the Add Files Button.

Clicking the Add Files button will open all files selected and add their metadata to the
grid. The field names and their associated data will be parsed and placed in the right
columns. If you make a mistake or want to deal with a new set of data simply click the
Clear Grid button to clear all the data from the grid.

Editing and Arranging

Once you have all the files loaded that you want to include, you can re-arrange the
columns and re-sort the data on any field. As in BWF-Widget Pro you can drag the
columns left and right by using the mouse to Right-Click on the field title and drag it to
the position you want it go appear... You can also delete columns if you don't need to
see that particular field in your reports. To delete a column just select the column by
clicking on the top of the column and pressing the Delete Key. You can also add
columns by clicking on the "Add Column™ button. You will be prompted for a title for
e the new column and then it will be
created in the last position on the right.
To edit or add new data to any cell just
double-click on any cell to bring up the

POLY 16 Bit 2 Trk
11} POLY 16 Bit 2 Trk
11} POLY 16 Bit 2 Trk

00  POLY 16 Bit 2 Trk edit box.

00  POLY 16 Bit 2 Trk

00  POLY 16Bit 2 Trk Type whatever new text you want to add
L LIER LSRRI in the entry box and Press Return to

00 POLY 16Bit 2 Trk fincomplete Take] accept your new entry. Pressing "Esc”
00  POLY 16Bit 2 Trk

TR EIEE exits the entry box and leaves any data
00 POLY 1EBit 2 Trk that was there before unchanged. You
00  POLY 16Bit 2 Trk can also Copy, Cut and Paste the
contents of individual cells using the standard Microsoft hot-keys of Ctrl-C, Ctrl-X, and
Ctrl-V for Copy, Cut and Paste respectively.

You can sort the data in the grid on any field by double clicking on the column title for
that field. Double Clicking on the Grid Title will cause the grid to automatically adjust all
the column widths to accommodate the widest entry in each column. You can also
manually adjust the column widths using the mouse to click and drag the dividers in the
header labels.
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Copy Cell across Selection

You may want to enter the same data in a number of rows, such as when adding an
additional column for Tape Number or Roll # to your database. To enter the same text in
a number of Cells in a column, first enter the text in the first cell. (See Above). Then
Select that cell and extend the selection down the column by dragging the mouse pointer
down the grid. Once the key cell and a group of cells in a single column are selected you
can Right-Click on the selection and choose "Copy Cell Down Selection™ from the popup
menu.

I e in the first cell will be

Duration | Tape # copied into all the cells selected in

DUIM:A92¢ ¢ the column. You can copy Up or
g Down with the Key cell being at
6 00:00:20:29

00:00:09:16 the top or bottom of your

00:00:09:16 [N DelaksSelnttat 1o selection. You can also use the

Copy Cell Down Selection Shi
-00:09:16 [N ift Key + Cursor Up/Down or
AN k opy Selection to Chpboard y P

00:00:09:16 [ Page Up/Down to extend your
Clear Selected Cell ) .

00:00:09:16 [ P?'E"S F‘;“.e s selection longer distances.

00:00:09:16 Rk AL HE

00:00:08:03

This menu Item only appears when you have a number of cells selected in a single
column.

Searching and creating Sub-sections

: . BWF-D-Base
File | Yiew Help

From the View Menu click on Search
Window (or use the Hot-Key Ctrl+F) to open
the search window.

The search window contains a second Grid
3 that will collect the results form any searches
you conduct.

Type a search term in the

e Preview Report Frint Search Results _Elear Results
box at the top left of the s - =

screen and choose what
field you want to search
for that specific data.

If you don't choose a
single field the program
will search all fields for
the data typed in the
"Search For" box.
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You can search for scene numbers, User Bits, Time Codes anything that would appear in
the metadata in the main grid. Clicking the "GQO" button or pressing Return in the Search
box initiates the search. The metadata in the main grid will be searched and all Items
that contain any of the matching data will be added to the Search Results grid. Just like
the main Data Grid you can save these results as a data file, or print a report that includes
only the data from this sub-search by clicking on the appropriate button at the top of the
Search Data Window. You can also edit and re-arrange the data in the search Data Grid
to include only the data you want in your reports.

If the search results contain items that you don't want to include you can use the Mouse to
click and drag down the first column to highlight the rows you don't want and then Right-
Click to and select Delete Selected Rows from the popup context menu. You can also
choose to Clear selected cells, Copy the Selection to the Clipboard, or Print the selection
or save the selection out to a new data file.. You can clear the results Grid by clicking on
the Clear Results button. If you wish you can accumulate the results from several
Different searches into the results grid.

Search Data

Frint Search Results Clear Fesults
SEARCH FOR n
26 Files In Take # Order
Filename Scene # Take # Start TC EndTC Dration User Bits Frame Rate [N
20171 i 201 11:25:53:00 11:26:50:00 00:00:51:00 04/27/06-00 23.976-MD
2017 2 i 201 11:23:06:00 11:25:43:00 00:00:43:00 04,/27/06-00 23.976-HD
2017 3wdhh 201 11:31:17.00 11:31.57.00 00:00;40:00 04/27/06-00 23.976-MD
2017 4 b 201 11:32:23:00 11:33:05:00 00:00; 4200 04,27 /06-00 23.976-MD

201 : : : 04/27/06-00 23.976-MD
E 0o 3 ] D

Clear Selected Cells
201711 Prink Selection A1 00 J0E-00 E-MD
201T12 w0 T TTaTIrog T1:42:18.00 00:00:41:00 04427 /06-00 23.97E-MD
201T13wAY 13 11:43:06:00 11:43:43.00 00:00; 3700 04/27/06-00 23.976-MD
201T14 AN 14 11:43:55:00 11:44:31:00 00:00: 36:00 04,/27/06-00 23.976-HD
201 T15AY 15 11:44:41:00 11:45:13.00 00:00;38:00 04/27/06-00 23.976-MD
201 T1E AN 16 11:48:10:00 11:48:53.00 00:00;43:00 04,27 /06-00 23.976-MD

201TT7. AN 17 11:43:36:00 11:50:05:00 00:00; 2300 04/27/06-00 23.8?B-ND—I;|
3

Save As ALE File for Metadata and File Import to AVID and Final Cut Pro

ALE is short for AVID Log Exchange format. It is a type of a ASCII Data file that is
compatible with most AVID and some Pro-Tools Editing systems. Creating an ALE file
will allow you to import the files and much of their metadata directly into an AVID
editing project. To Save as an ALE file choose "Save Data File As" from the main File
Menu. When the Save As dialogue box is displayed choose "AVID Log File (ALE)" in
the dropdown selection box labeled "Save as type:" Then when you click the "Save"
button the ALE file will be created and saved to the folder you selected.

NOTE: ALE files must have certain metadata to be legal. So make sure the following
columns are in the Data Grid before you try to save an ALE file.
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The following 4 data columns are the minimum required for ALE file creation:

1. Filename: 2. Mode 3.Start TC  4.End TC

The remaining metadata columns will be used as needed in the ALE file. The More
metadata you include in the Grid the more complete the metadata in the AVID project
will be. Especially useful are "Notes™" and "Track 1Ds". Also make sure you fill in the
Header data fields from the Report Header (see next section) before you Save an ALE
file as some of this information is used to create the ALE formatted file.

Save a selection from the Data Grid Or Search Results Grid to a file.

You can use the mouse to select a subset of the entire data grid. Click and drag across the
column heads to highlight a series of columns within the grid or Drag down the Row
Headers to highlight a series of row entries within the grid. Then Right-Click on the
selection and Choose "Save Selected Data™ in the pop-up menu. You can also select a
block of data within the grid by holding down the mouse button on the cell for the upper
left corner of the block and dragging down to the lower right cell of the block you want to
select. This subset, along with the column heads will be saved to a file with the prefix
"SubSect" and the name of the folder and the type of sort. Or you can use "Save
Selection As" to rename the file and place it wherever you like. You can also use "Save
Selected Data" to create an ALE file of just the selected takes. Simply choose "AVID
ALE FILE" in the File Type Drop down in the Save As dialogue box before saving the
selection.

Printing Reports

Before printing any reports you need to setup the printer in the Options Menu

From the View menu choose Options to reveal the options menu. The Printer settings
control how your reports will be formatted. You first need to select a printer for Printing
from the drop-down list.

Dose | OPTIONS MENU

Printer Settings

Select Printer for Repart Printing: _Prewies I [v Prirt Header
I Molobe PDF j [+ Add Seperatar Lines
A ¥ Hide Fath on Printout
opies =

— Color Picker

Left Click=FG Col
{1 I SAMPLE COLOR

Drefauilt
i Colors

Grid1l  Grd2  Grid3  Grid 4

Choose paper orientation (portrait or Landscape) and the font-size for the data in the
printout. If you preview the printout by pressing the preview button and the columns are
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running off the right side of the page you need to reduce the Printout font size using the
slider, or choose Landscape to allow for wider columns of data.

If the Print Header box is checked the data in the Header will be printed on the first page
of any reports. If this box is unchecked only the data from the grid with the field titles
will be shown on the printed reports. Separator lines will be added if checkbox is
selected and whenever the color in the grid background changes from one color to
another. That coloring indicates any changes that occur in the filed sorted on.

Left click or Right Click on the Copies Label to increase or decrease the number of
copies of the report you want to printout..

Setting up the Report Header

In the View Menu choose Report Header or use the Ctrl+H hot-key to bring up the
Header layout window.

-l
enodion, SO[TND REPORT ROLL / TAPE / DISK #

BW{_WI D('a PR@ Created With EvyF-D-Baze - wwew v fuviclget.com 2
[R——

www.bwfwidget.com

DATE: |3:2?.-2006 |

PROJECT TITLE: |MY BIG Project Database | FILE FORMAT: |BWF Poly
FRODUCTION C2: |Goodsound Productions Inc. DISE FORMAT: (UDP DVD+
MIXER/ENGINEER: |Courtney Goodin TIME CODE: |30 FRND |
1B #: (54345354 | REcoRDER: [SD744 |
Clear ,.'.-._||| Top Margin: ﬁjﬁ 0.20 Inches

Enter the information you want to appear in your report header in the boxes .

Click on the Clear All buttonto clear allthe g ® T TWiILIWUT ]| =—

fields in the header. Any entries will remain www.bwfwidget.com

until they are changed or cleared. You can

also edit the field labels to be whatever is

appropriate for your reports. Hold down the PROTECT TITLE: |MY BIG Project Data
Shift Key and Click on any field Label to
change it. Adjust the slider to add a top
margin to your reports (up to .5 inches)
The top margin will be added to the top of JOB #: 54345354
the first page when printed. Use this only if
your printer is clipping the top of the report.

msinlijegniagasr |(Goodsound Production

MIZEE f ENGINEL\@: Courtney Goodin

You can have your own logo replace the BWF-Widget Pro logo by placing a bitmap file
named "HeadLogo.bmp™ of your logo that is approximately 400 pixels wide by 200
pixels high or bigger in the same folder as the BWF-D-Base Program file.
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When you close the Report Header Window all your changes will be saved and will be
used each time you print a report.

NOTE: The "DATE:" field automatically loads the current system date each time you
open the Header Entry window. To disable this auto-date function simple change the
field label from "DATE:" to something else. You can just add a space between the "E" in
DATE and the ":" colon will change the field enough to disable the auto-Date entry. You
may then manually enter the date or any other entry you may want in that field. To re-
enable the Auto-Date Function change the Field Label back to "DATE:".

Reports can contain just the Search results or the entire contents of the main Data grid.
Remember to save your search results or main collection of files if you want to re-load

the source files without having to re-select all the individual files to merge again if you
didn't save the collective file.
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